
ESSENTIAL Connection ControlCOMPREHENSIVE Lab Control





3

About Faronics
Faronics delivers market-leading solutions that help manage, simplify, and secure complex IT 
environments. Our products ensure 100% machine availability, and have dramatically impacted the 
day-to-day lives of thousands of information technology professionals. Fueled by a market-centric 
focus, Faronics’ technology innovations benefit educational institutions, health care facilities, libraries, 
government organizations and corporations.

Technical Support
Every effort has been made to design this software for ease of use and to be problem free. If problems 
are encountered, contact Technical Support:

Email: 		  support@faronics.com

Phone: 		  800-943-6422 or 604-637-3333

Hours:		  7:00am to 5:00pm (Pacific Time)

Contact Information
Web:		  www.faronics.com

Email:		  sales@faronics.com

Phone:		  800-943-6422 or 604-637-3333

Fax:		  800-943-6488 or 604-637-8188

Hours:		  7:00am to 5:00pm (Pacific Time)

Address:		  Faronics Technologies USA Inc.
			   2411 Old Crow Canyon Road, Suite 170
			   San Ramon, CA 94583
			   USA

			   Faronics Corporation
			   609 Granville Street, Suite 620
			   Vancouver, BC V7Y 1G5
			   Canada

Last modified: October, 2009
© 1999 - 2009 Faronics Corporation. All rights reserved. Faronics, Deep Freeze, Deep Freeze Mac, Faronics Core Console, Faronics 
Anti-Executable, Faronics Device Filter Mac, Faronics Power Save, Faronics Power Save Mac, Faronics Insight, Faronics System 
Profiler, and WINSelect are trademarks and/or registered trademarks of Faronics Corporation. All other company and product 
names are trademarks of their respective owners.
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About Insight
Computers in schools have the power to enhance the classroom experience for both students and 
teachers. But the benefits can easily be lost to distractive elements such as games, instant messaging, and 
web surfing. Best suited for K–12 classroom environments, Faronics Insight is the ultimate classroom 
technology management system that empowers teachers with the ability to share their screen with 
students, control student access to applications and Web sites, and monitor classroom screens to ensure 
students are on task. Students enjoy the ability to interact with the teacher directly through Insight’s 
chat, voting, and remote assistance capabilities.

With Insight installed on each computer in a classroom, a teacher has the ability to: 

Reduce Student Distractions
A teacher can reduce student distractions by Blanking Screens, Limiting Applications, or Limiting Web 
Browsing on student computers. This helps direct student attention from their computer to the teacher 
and keeps students on task.

Demonstrate Skills
With the Show Teacher feature, students can observe the teacher’s computer right from their own 
monitor. This is ideal for presentations and showing students how to use computer applications.

Keep Students on Task
The Monitor feature allows the teacher to view all or any students screens as well as glance at the 
current application and Web sites that the students are running.

Encourage Classroom Participation and Collaboration
Voting is the ability to assess the student’s understanding of the classroom material by asking questions 
that the students answer anonymously.

Help Individual Students
Students can silently Request Help from the teacher. A small question mark appears by their login name 
which indicates they need help. At that point the teacher can Chat with the student or Remotely Control 
their machine to help them with their question.

System Components
Insight is comprised of three main parts. The Insight console which is installed on the teacher computer, 
contains all the features and commands used to control and monitor student computers.

The Insight task bar menu is the abbreviated version of the Insight console which contains the most 
commonly used commands. It is opened by right-clicking on the Insight taskbar icon.

The student computer is where students follow the teacher or complete assigned activities. 

The Insight Home Edition works with a maximum of three student workstations and does not have the 
option to specify the channel during installation. With the Insight Home Edition, you can only operate 
on the default channel and you do not have the option to change the channel after installation. 

Understanding how Insight works
Insight works by enabling a teacher to control all student computers within a computer-based classroom. 
It uses teacher channels to ensure that all the computers in that classroom see the same computer 
screen. Insight has 16,000 teacher channels from which to choose. Therefore, an organization can have 
as many as 16,000 different classrooms using Insight at any given time. The most logical way to set 
up Insight is for each classroom or room to have its own teacher channel, as well as just one teacher 
computer. This setup enables all of the computers in the same classroom to interact with each other and 
one teacher to control the entire room.
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Supported Environments
Insight must run on the teacher and student computers using one of the following operating systems:

- Windows 2000, Windows XP, Windows Vista (32 & 64-bit), Windows 7, Windows 2003 Terminal Server, 
Windows Server 2008 and NComputing.

- Mac OS X v10.4, v10.5, and v10.6 (Insight Teacher Console will only run on Intel-based Mac computers).

Screen Resolution 
Insight is optimized for 1024x768 and 1280x1024 screen resolutions for the teacher or student.

Protocol Stack
All computers running Insight must be configured with TCP/IP running static or dynamic IP addresses. 
802.11 wireless is supported; however, enterprise class access points are recommended.

Performance Improvements

The Insight Console, Remote Control, and Thumbnails have been enhanced in Insight to perform more 
reliably and quicker than in previous versions.
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Installing Insight
Before installing Insight, review the requirements and ensure the network and lab computers are 
running smoothly. Doing so will prevent problems during installation.

The Insight product CD or download includes the files needed to install the Insight application, as well 
an electronic copy of this user guide in .pdf format. Adobe Reader is available on the Insight CD in the 
Acrobat folder, or free from the Adobe Web site at: http://www.adobe.com.

Planning the Installation
By taking a few minutes to plan out the teacher installation, the administrator should be able to install 
Insight on each computer in two minutes or less. Consider these issues before beginning installation:

Choose a unique teacher channel for each lab
Insight is designed to work with as many as 16,000 different training labs on the same network. It uses 
teacher channels to broadcast the contents of a teacher’s computer to student computers on the same 
channel. To simplify installation, each lab should have its own unique channel, as well as just one 
teacher computer.

If only one Insight lab is on the network, the teacher can choose any number from 1 to 16,000. If there 
are multiple Insight labs, each requires its own unique teacher channel number. 

Choosing channel 0 as the teacher channel allows the teacher to monitor workstations 
assigned to all Insight channels including other teacher workstation actions.

For each lab, choose one teacher computer
Set up one teacher computer per lab. The teacher uses this computer to control all student computers 
in the same lab. During installation, specify if the computer is a teacher or student computer.

Configure a valid TCP/IP protocol stack for all student and teacher computers
If the computers are using DHCP, then DHCP must be working properly. The teacher and student 
computers should all be on the same IP subnet.

Set all teacher and student computers to the same screen resolution
Although not required, it is recommended that all computers be set to the same physical screen size. 
Insight has been tested on 1024x768 and 1280x1024 screen resolutions.

Use good networking hardware and software
If there are problems logging onto computers or copying files over the network, fix these issues before 
installing Insight.

Use an enterprise class access point
If the teacher plans on using Insight over a wireless network, it is important to use an enterprise class 
access point. Personal home network wireless access points are not robust enough to handle many 
connections.

http://www.adobe.com
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Run Insight Setup on Windows
The Insight Setup program (Student.msi/Teacher.msi) must be run on each teacher and student 
computer.

Insight installs to the C:\Program Files\Faronics\Insight folder on each computer and stores all files 
locally on each computer. Once the installation is complete, the student or teacher program starts. The 
program also re-starts every time someone logs on to the computer. 

If the teacher computer doesn’t have a CD-ROM drive
The Insight file (Student.msi/Teacher.msi) is small enough that it can be copied to a flash drive from the 
product CD. Insight can also be unzipped directly to a flash drive or any shared location on a network 
and installed from there.

To install Insight on a teacher or student computer

1. Insert the product CD into the computer’s CD-ROM drive. If Insight has been obtained 
via a secure download, navigate to the location where the download has been stored.

2. In My Computer, go to the CD-ROM, flash drive, or network drive and double-click 
Student.msi/Teacher.msi.

3. Click Next.
4. Read the license agreement that appears, then click I Accept, then Click Next.
5. Choose a teacher channel number (1 to 16,000), then click Next. Choose a unique number 

for each lab or room.
6. To set any Advanced Options, select the check box Check to configure advanced options. 

Set any advanced options. Most of these options apply to the teacher machine when it 
becomes a student machine.

Stealth Mode – If checked the student will not see the Insight icon and will not be able to 
ask the teacher questions through Insight.

Student can change channels – If checked the student will be able to change channels. This 
option is only recommended for 1:1 schools.

No keyboard monitoring – If checked the student’s keystrokes will not be logged.

Secure mode – If checked a teacher must enter a password to manage the student. We 
recommend that the same password be used for the whole class or school. If you forget 
the password, you must re-install the software.

Click Next.
7. Click Install to finish the installation. Every time someone logs on to the computer, Insight 

automatically loads all of its files ready to use.

The Student.msi/Teacher.msi file should be kept hidden so that unauthorized users are 
prevented from uninstalling Insight

Run Insight Setup on Mac
The Insight Setup program must be run on each student or teacher computer.

Insight installs on the hard disk and stores all files locally on each computer. Once the installation is 
complete, the student program starts. The program also re-starts every time someone logs on to the 
computer. 
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Installing Insight Teacher
The Insight file (faronics_teacher.dmg/ faronics_student.dmg) is small enough that it can be copied to 
a flash drive from the product CD. Insight can also be unzipped directly to a flash drive or any shared 
location on a network and installed from there.

To install Insight Teacher

1. Copy faronics_teacher.dmg to the Mac teacher computer
2. Double click on faronics_teacher.dmg.
3. Double click on faronics_teacher.pkg.
4. Follow the installation wizard to the Teacher channel option – Select a teacher channel 

number (1 to 16,000).  Choose a unique number for each lab or room.
5. If necessary select Advanced Options.  This page allows you to set the following options for 

when a teacher becomes a student from the Administer menu in the Teacher console:

Stealth Mode – If checked the student will not see the Insight icon and will not be able to 
ask the teacher questions through Insight.

Allow student to change channels – If checked the student will be able to change channels.  
This option is only recommended for 1:1 schools.

Disable keyboard monitoring – If checked the student’s keystrokes will not be logged.

Secure mode – If checked a teacher must enter a password to manage the student.  We 
recommend that the same password be used for the whole class or school.  If you forget 
the password, you must re-install the software

6. Click Continue. The installation location cannot be changed.  Insight must be installed on 
the system drive.

7. Click Install. The installer will ask you for the administrator password on that machine.  
Type in the password and click OK.

8. After the installation is successful, click the Close button on the final page of the wizard.
9. If you want teachers to have the ability to change the channel, you must double-click on 

the EnableChannelSelect utility located in the Utilites folder in the faronics_teacher.dmg.

To install Insight on a student computer

1. Navigate to the location where the download has been stored.
2. Go to the hard disk or network drive and double-click faronics_student.dmg.
3. Click Continue.
4. The installer appears. The Introduction screen is displayed. Click Continue.
5. The License screen appears. Click Continue. Click Agree to accept the license agreement.
6. The Options screen appears. Select the required options. Click Continue.
7. The Destination Select screen appears. Select the destination where Insight will be installed. 

Click Continue.
8. The Installation Type screen appears. Click Install.
9. If the installation is successful, the message Install Succeeded is displayed. Click Close.
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Features available in Insight Mac
All features available in the Windows version are also available in the Mac version except for the 
following:

Teacher Console Test Creation, Draw On Screen, Properties Dialog, Teacher 
Profiles, Status View, Switch to Teacher, Power On, Classroom 
Layout, Thumbnail best fit mode, Thumbnails selected only mode, 
Show thumbnails tooltips option, Thumbnail magnify option,  
Show application and web icons on the thumbnail, Disable keyboard/
mouse during remote control

Other features Security (Active Directory Group membership), Web Limiting in Firefox, 
Support for Internet Explorer 8 (Private Browsing does not log history)

Installing Insight in Active Directory Secure Mode
Insight has the ability to leverage Windows Active Directory to ensure that only authorized teachers 
can control students. This mode adds an extra level of security to prevent unauthorized consoles 
from being used. This mode will only function in an Active Directory Domain environment.  To fully 
configure this mode, you must have Domain Rights to create and populate a domain User Group.

1. To install the Active Directory Secure Mode, select the teacher or student installation.
2. Click on the Advanced Options checkbox.
3. Select Active Directory Secure Mode.
4. Repeat these steps for both teacher or student computers

When in this mode, a teacher must be a member of the Domain User Group Insight Teachers. If the 
teacher is not a member of that group, then Active Directory Secure students will not interact with that 
teacher. Creation of the Insight Teachers Domain User Group is done using the appropriate Windows 
Server 2003 or 2008 Active Directory tools. Once the group has been created, those same tools can be 
used to populate the group with the appropriate teachers.

Active Directory Secure Mode is not available yet for Mac teachers or students.
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Scripting or Mass Deploying Insight via MSI
 
If you want to run teacher.msi or student.msi from a script or desktop management tool, there are 
command-line options to install Insight.  Run msiexec.exe and each value should be set to a non-null 
value such as 1 to enable that feature.  Msiexe.exe command-line parameters are found by running 
msiexec.exe.  Msiexec.exe is a Microsoft program.

CHANNEL=”X” - Installs Insight with the Teacher Channel X. “X” must be an integer number from 1 
to 16000.

ADVANCED_OPTIONS - Required to set advanced options

STEALTH_MODE - When set to a non-null value, the Insight icon will not be shown on the student 
computer. 

STUDENT_CHANGE_CHANNEL_MODE - When set to a non-null value, the student can change 
teacher channels.

NO_KEYBOARD_MONITORING_MODE - When set to a non-null value, student keystrokes will 
not be captured.

AD_SECURE_MODE - When set to a non-null value, the teacher or student will enter Active Directory 
Security Mode.  Only teachers that are a member of the  Domain User Group Insight Teachers will be 
able to manage those students.

SECURE_MODE - When set to a non-null value, the secure version of the product is installed that 
requires a password be entered on the teacher console.

PASSWORD - A password is required when turning on secure mode

PASSWORD_CONFIRM - Confirmation of the password is required when turning on secure mode

ENABLECHANNELSELECT - When set to a non-null value, the teacher can change channels to view 
different classrooms.

For example, if you want to silently install a secure mode teacher that can change channels but starts 
on channel 3, with a password of test, your script should look like this:

Msiexec.exe /i “<path to teacher.msi>\teacher.msi” /qn ADVANCED_OPTIONS=1 SECURE_

MODE=1 PASSWORD=test PASSWORD_CONFIRM=test CHANNEL=3 ENABLECHANNELSELECT=1

Automated Install for Insight Mac
Insight can be remotely, automatically installed with any tool that can remotely deploy installer 
packages. 

When Installer packages are run by an automated install, there is no opportunity to enter information 
in the interface such as channel number or password. 

The Insight settings are controlled by a secure file called com.faronics.student.settings.plist. 

The following syntax shows the default XML file settings:

<?xml version=”1.0” encoding=”UTF-8”?>

<!DOCTYPE plist PUBLIC “-//Apple//DTD PLIST 1.0//EN” “http://www.apple.com/DTDs/

PropertyList-1.0.dtd”>

<plist version=”1.0”>
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<dict>

	 <key>AllowKeyboardMonitoring</key>

	 <integer>1</integer>

	 <key>OneToOne</key>

	 <integer>0</integer>

	 <key>SecureMode</key>

	 <integer>0</integer>

	 <key>StealthMode</key>

	 <integer>0</integer>

	 <key>Channel</key>

	 <integer>1</integer>

	 <key>LogLevel</key>

	 <integer>0</integer>

</dict>

</plist>

Each option in the file is followed by a value surrounded by <integer> and </integer>. The value 
following the option name determines whether the setting is on (1) or off (0). LogLevel sets the error 
logging on when set to (1).  If you are doing a remote, automated deployment and you need to configure 
the student differently than the default settings, there are two ways to proceed: by modifying the settings 
file inside the package before installation, and by using the lsconfig utility any time after installation.

Modifying the Settings File inside the package

The easiest way to configure the student settings is to modify this file inside the package and then 
deploy the package to your computers. It can be easily modified on a Mac by right clicking (or control-
clicking) the faronics_setup.pkg file and selecting Show Package Contents. The file is /Contents/Resources/
com.faronics.student.settings.plist. Use your favorite text editor to modify the values according to your 
desired configuration. Using the package with the modified settings file will allow the install to work 
correctly in a remote automated deployment.

Reconfiguring Insight using the lsconfig utility

Insight Mac can be reconfigured using the lsconfig utility located in /Library/Application Support/
Faronics/Insight on the Student computer. This utility is installed on each Mac client. This utility can 
only be run by the super user (Administrator). The following parameters are available for automated 
install:

StealthMode
After installing in Stealth Mode, the Insight icon is not displayed 
in the System Tray. 

Channel Sets the Teacher Channel.

AllowKeyboardMonitoring
Once installed, the Teacher will not be able to monitor the 
keystrokes on the Student computers.

OneToOne
One to One also allows the student machine to join other classrooms 
by changing to a different teacher channel without restarting.

SecureMode Sets whether or not the student is in Secure Mode.
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LogLevel Sets the error logging.

Example Command Line:

sudo./lsconfig Channel 24

The above command changes the teacher channel to 24. The other options can be configured by simply 
using the option and the desired value, usually a 1 or a 0, except in the case of the teacher channel 
where the value is between 1 and 16,000. After changing the student settings the lsconfig utility can 
restart the student software with the following command line:

sudo./lsconfig/restart

Stealth Mode
Insight provides an additional feature that allows you to install the application in Stealth Mode. After 
installing in Stealth Mode, the Insight icon is not displayed in the System Tray. 

Secure Mode
Insight provides an additional feature that allows you to install the application in Secure Mode. 
After installing in Secure Mode, unauthorized users are prevented from accessing the channel. The 
communication between student and teacher is protected by a password that can be specified during 
installation. Students and Teachers with the same password can communicate with each other on a 
single channel. 

Kiosk Mode
Insight provides an additional feature that allows you to install the Teacher console in Kiosk Mode. 
After installing in Kiosk Mode, the Teacher console cannot be Maximized, Minimized or Resized. 

The Kiosk Mode can be enabled after installing Insight. For enabling the Kiosk Mode, complete the 
following steps:

1. Install the Teacher console.
2. Got to Start>Run>Regedit.exe.

3.
Browse to 

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Run

4.
Add KiOsK to the Insight Teacher key and specify 

C:\Program Files\Faronics\Insight\Teacher.exe KiOsK

5. Click OK.

When the computer is rebooted, the Teacher console can be launched in Kiosk Mode only. The Kiosk 
Mode feature is not available in the Insight Home Edition.

No Keyboard Monitoring
Insight provides an additional feature that allows you to install the application without the Keyboard 
Monitoring feature. Once installed, the Teacher will not be able to monitor the keystrokes on the 
Student computers.

One to One
Insight provides an additional feature that allows a teacher to move between different classrooms while 
keeping class lists organized and updated in real time. One to One also allows the student machine to 
join other classrooms by changing to a different teacher channel without restarting. 
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Once Insight is installed
On the teacher computer, the Insight icon appears in the System Tray. To begin using Insight, double-
click the icon to open the Insight console.

On student computers, the same Insight icon appears in the System Tray. Placing the cursor over the 
icon displays the teacher channel and IP address used by the student computer. Double-click the icon 
to open Insight. You can right-click the icon to display a quick menu with additional options.

Additional Insight Utilities
Additional utilities can be found in the Utilities folder on the Insight CD-ROM or secure download. 
Use one or more of the following .exe files to enhance and customize Insight based on the type of 
classroom environment. The following utilities are not available in the Insight Home Edition.

Utility Executable Description

Channel Selector EnableChannelSelect.exe Allows the teacher to set multiple channels 
(teacher computer only)

IP Directed Broadcast DirBcastAddr.exe
Calculates the IP address to allow 
the teacher to broadcast to student 
workstations across different subnets

Switch to Teacher SwitchToTeacher.exe Allows the student machine to become a 
teacher machine until the next reboot

Wake Up WakeUp.exe Tests Wake-On-LAN functionality

Changing Channels
If the teacher needs to change the channel of student computers they can do any of the following:

1. Reinstall the product and select a new channel.
2. Run setchannel.exe, which is located in the utilities directory (applicable only for Insight 

7.0).
3. Change the channel from the Insight console. If EnableChannelSelect.exe has been run by 

an administrator, the teacher can change the student channels from the console using the 
following procedure:
a. Select the machines.
b. Click Administer > Change Student Channel.
c. Select the new channel
d. Click OK.
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Configuring Insight Options
Insight options are controlled by one dialog with five tabs. Most options are controlled by making a 
change to these settings on the teacher computer. To change these settings select the Administer menu 
followed by Options.

The available configuration tabs are:

• Teacher

• Student

• Web Limiting

• Application Limiting

• Network

Configuring Teacher Options
The Teacher tab configures the following options:

Show Teacher Screen
Full Screen

Displays the teacher’s screen on the selected student’s screens. The students will not be able to control 
their mouse devices and keyboards during Show Teacher.

Windowed

Displays the teacher’s screen in a window on the selected student’s screens. The students can follow 
along with the teacher and use their own computers. Students can also resize/position the window to 
ensure they can work while receiving instructions.

Color Reduction

Limits the number of colors used by the teacher during Screen Broadcast and Remote Control. This 
improves performance and lowers network bandwidth requirement.
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Teacher Video Accelerator

Performance

Enables the Teacher Video Accelerator. It improves Teacher-Broadcast performance. This option is only 
available on Windows 2000 or higher machines. 

Compatibility

Disables the Teacher Video Accelerator. This should only be selected if the Teacher-Broadcast mode 
does not work properly with OpenGL or DirectX applications.

Blank Screens Message

Edits the text displayed on the student’s screens while they are blanked.

Student Options

The Student tab configures the following options:

Remote Control
Disable Student Keyboard and Mouse

Prevents the student from using their input devices while the teacher is controlling the student’s 
computer remotely.

Student Thumbnails
Thumbnail Size

Allows the teacher to determine the thumbnail size when monitoring student computers. The best 
fit option automatically chooses a thumbnail size based on the number of students and the available 
screen area. The teacher can choose from four thumbnail sizes; the smallest size allows the teacher to 
see more than 80 student machines on a 15 inch monitor without having to scroll.

Show Current Application Icon on Thumbnails

When in the thumbnail view, this option shows an icon in the upper left hand corner that represents 
the application that the student is running.
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Show Last Visited Web site Icon on Thumbnails

When in the thumbnail view, this option shows an icon in the upper right hand corner that represents 
the Web site the student visited last.

Limit Task Manager
The Task Manager is disabled on the student computer by default. To enable the Task Manager, clear 
the Limit Task Manager on Student check box.

Insight Folder on Student
Specifies the path of the Insight folder on student machines. This can be on the machine’s hard drive 
or on a network drive.

Web Limiting
The Web Limiting tab configures the following options:

Block All
Blocks all web browsing, instant messaging and e-mail programs.

Allowed Web sites
This option allows the teacher to enter a list of web sites that are allowed when Limit Web is turned on. 
Lists of web sites can be saved and loaded by using the Load and Save buttons. The files are saved as .lsu 
files. The teacher can use the wildcard characters * and ? to allow certain kinds of web sites. The web 
sites that are not listed here will be blocked.

Block the Following Web sites
This option allows the teacher to enter a list of web sites that are blocked when Limit Web is turned on. 
Lists of web sites can be saved and loaded by using the Load and Save buttons. The files are saved as .lsu 
files. The teacher can use the wildcard characters * and ? to block certain kinds of web sites. The web 
sites that are not listed here will be accessible.

You can select only one option from ‘Allowed Web sites’ or ‘Block the Following Web 
sites’ at the same time.
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Display notification on student when web is accessed
This option turns on or off the notice that is displayed on the student’s screen when they try to access 
a Web site or application when Web Limiting is turned on.

The Web Limiting feature is supported on Microsoft Internet Explorer only. All other 
browsers are closed when the Web Limiting feature is enabled.

Application Limiting
The Application Limiting tab configures the following options:

Allowed Applications
Specify a list of permissible applications when Limit Applications is turned on. Lists of applications can 
be saved and loaded by using the Load and Save buttons. The files are saved as .lsa files.

Applications can be typed in directly or by clicking on the Add button and selecting an active application 
on the teacher’s computer. Add an application from the student’s machine by clicking on View Student’s 
Running Programs in the Monitor menu.

Blocked Applications
Specify a list of applications that are blocked when Limit Applications is turned on. Lists of applications 
can be saved and loaded by using the Load and Save buttons. The files are saved as .lsa files.

Applications can be typed in directly, added by clicking on the add button and by selecting an active 
application on the teacher’s computer. Add an application from the student’s machine by clicking on 
View Student’s Running Programs in the Monitor menu.

You can select only one option from ‘Allowed Applications’ or ‘Blocked Applications’ at 
the same time.
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Network
The Network tab configures the following options:

Data Transmission
IP-Broadcast

This default option uses broadcast packets when the teacher needs to contact all student machines.

Broadcast packets do not cross subnets or VLANs. If the teacher needs to cross a subnet or VLAN, IP-
Multicast, or IP-Directed Broadcast are recommended.

IP-Multicast

Transports Insight data to students via TCP/IP-Multicast. Multicast allows networking hardware to 
keep Insight traffic local to Insight computers. If the network hardware supports this option, it is highly 
recommended. Because some network routers or switches do not support Multicast, this option is 
disabled by default.

IP-Directed Broadcast

If the teacher is on a different IP-Subnet from some or all of the students, and Multicast is not possible, 
this option can be used. To calculate the proper address, use the DirBCastAddr.exe utility in the Utilities 
folder on the Insight CD-ROM.

Some additional configuration of the routers/switches may be needed to enable 
Multicast and/or Directed Broadcasts on the network. Consult the network hardware 
guide for the switches/routers to be sure.
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Multiple Network Adapters

Specify Network Interface Card
Some computers have more than one Network Interface Card (NIC) and/or multiple IP addresses (e.g. 
a router). These may be virtual or wireless network adapters.

Insight always uses the first NIC, but that is not always the desired NIC or network. Use this check box 
to specify which NIC to use.

If the teacher computer has multiple real or virtual network adapters, specify the adapter that Insight 
should use.

Teacher Channel
Insight is designed to work with as many as 16,000 different training labs on the same network. It uses 
teacher channels to broadcast the contents of a teacher’s computer to student computers on the same 
channel. To simplify installation, each lab should have its own unique channel, as well as just one 
teacher computer.

If only one Insight lab is on the network, the teacher can choose any number from 1 to 16,000. If there 
are multiple Insight labs, each requires its own unique teacher channel number. 

This feature is normally disabled to prevent an accidental change to the channel number. Even though 
the option is greyed out, it still displays the Teacher Channel configured for this machine.

There is a free utility called EnableChannelSelect.exe that is available in the Utilities directory on the 
CD-ROM.

If the Teacher Channel needs to be changed, this utility enables the channel number selector.

EnableChannelSelect.exe TRUE

EnableChannelSelect.exe FALSE

Choosing channel 0 as the teacher channel allows the teacher to monitor workstations 
assigned to all Insight channels.
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Using Insight

Using the Teacher Computer 
On the teacher computer, there is small Insight icon in the taskbar. The taskbar is located in the bottom 
right corner of the computer screen. Double-click the icon to open Insight. You can right-click the icon 
to display a quick menu with additional options. Use this menu to control the key features of Insight. 

Insight functionality can be accessed through a menu, icons, or a right-click menu. Manage student 
computers from either the list view or the enhanced thumbnail view.

Insight Console Tips
Most of the features that the teacher uses every day are accessible from the Insight taskbar menu. 
Some of the more advanced features are available in the Insight Console. All of the critical features are 
grouped under one of five menu items: Demonstrate, Monitor, Restrict, Administer, and View.

Listed below are some tips about using the Insight Console:

Insight Toolbar Buttons
To use a feature in Insight, select the student or students and click the Insight toolbar button that 
corresponds to the desired feature. The button will depress and change to a lighter color. To stop using 
that feature, click the button again.

Some of the Insight toolbar buttons have a small arrow to the right of the button. Click on the arrow to 
access additional options for that feature.

Activating Web and Application Limiting
Web and Application limiting must be configured before they can be activated. Configure these features 
in the Options menu located under Administer in the Teacher Console and turn them on through the 
menus or the toolbar.

Right-click
In the Insight console, access advanced features by right-clicking on a student computer in either the 
Detail or Thumbnail view.

Implicit All Selection
If no students are selected, there is an implied all selection when activating key features like Blank 
Screens or Show Teacher. If no students are selected and the teacher clicks the blank screens toolbar 
button, all of the student screens are blanked. A red outline appears around specifically selected 
machines in the thumbnail view and can be removed by clicking the thumbnail again. In the detailed 
view, the student details, computer name and other details are displayed. 

Refresh Screen
Pressing F5 or the menu item View followed by Refresh will refresh the console list by initiating a 
discovery of student computers.

Sorting
By default, the detail view is sorted alphabetically by the Login Name column. Click on any of the other 
column headings and the list will re-order alphabetically on the selected column.

Insight Taskbar Menu
A right-click on the Insight icon in the taskbar brings up a menu that contains the features most 
teachers use every day.
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A left-click on the notification area icon brings up the Insight Console.

Keyboard Shortcut for the Insight Menu 
Some teacher machines do not have a visible taskbar. Since it’s not possible to click on the non-visible 
icon, bring up the Insight Teacher’s menu with the Ctrl+Alt+l keyboard shortcut. 
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Using the Insight Menus
Aside from the features found on the Insight toolbar, there are additional commands available in the 
Insight Menus, which are:

• Demonstrate
• Monitor
• Restrict
• Administer
• View

Demonstrate
Show Teacher (Full Screen or Windowed)

This command allows for the display of the teacher’s screen on the screens of the students. Selecting 
to show the teacher’s screen is accompanied by a sound that indicates an Insight broadcast session is 
starting.

Draw on Screen

The teacher can illustrate their points by drawing on a student’s screen. In order for the students to 
better see the teacher’s cursor, a large red cursor appears in the student view. These cursors are the same 
shape as the real cursor, but are four times the size. 

To draw on the screen, first select the Show Teacher option. In the System Tray, right-click the Insight 
icon and select Draw on Screen. Once you have drawn the object on your screen, close the window. 
You can now de-select the Show Teacher Option to resume normal activity.

Show Student’s Screen to Students (Full Screen or Windowed)

Use other student’s computers as a teaching aid. This command broadcasts a student’s screen to the rest 
of the classroom workstations in Full Screen or Windowed mode. 

To show a student’s screen, select the thumbnail of the student’s computer in the detailed view.

Chat With Student 

Allows the teacher to communicate with a single student through a real time chat feature, just like 
today’s most popular instant messaging programs.

Run Program on Student Machine

Selecting this option opens the Run Program on Student Machine dialog. Type the path of the desired 
program or browse to its location. Once selected, the program will execute on any student workstations 
selected in Insight.

Clear Student Question

Use the clear student question feature once the question has been addressed.

Ask Students to Vote

Selecting this option opens the Send Question to Students dialog. Customize the question by selecting 
various options. Once the question is sent, Insight will calculate the answers and provide a summary. 
Questions can also be saved and loaded for future use as .lsq files.

Voting Results

The voting results are displayed in the Voting dialog. The Voting dialog displays the questions asked 
by the teacher and the students’ responses. The teacher can see how individual students answered the 
question and have the results exported to a text file. 
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Monitor
View Student Screen

Displays a selected student’s screen on the teacher’s machine in a full screen mode. The teacher cannot 
control the machine—only observe, and cannot view multiple students’ screens.

Remote Control Student

Similar to view student screen, a selected student’s screen is displayed. The teacher is able to control each 
workstation (open programs, navigate to Web sites, etc.). If the Disable Student Keyboard and Mouse 
check box is selected in the Student tab, the student’s input devices are disabled. More than one student 
workstation can be selected and controlled. (Only one screen will be displayed now matter how many 
are selected).

Send Ctrl+Alt+Delete 

This feature is only available while a selected student’s workstation is being controlled. The teacher can 
send the keyboard shortcut.

Save Snapshot of Student Screen

A snapshot of a selected student’s workstation can be taken and saved by Insight. Selecting this 
command opens the Save As dialog. The default file name is the workstation name. This file is saved 
with the .bmp or .jpg extension. Multiple student workstations can be selected.

View Student Internet History

Taken from the Internet Explorer history log, the list of visited URL’s for a selected student workstation 
is displayed. The history is not displayed for browsers other than Internet Explorer, nor is it displayed 
if the student clears Internet Explorer’s history log.

View Student Keystroke and Application History

The list of applications and keystrokes made on a student computer by any user (excluding keystrokes 
in any Windows login dialog) is monitored in real time. When the Keystroke Monitoring dialog is open, 
it refreshes automatically and shows student keystrokes in real time. If you scroll back to view previous 
keystrokes the automatic refresh is disabled until you scroll back to the bottom of the list.

View Student’s Running Programs

Allows the teacher to view programs running on selected student workstations. Any entry in the 
executable list can be selected and added to the Allowed or Blocked application list.

Send Message

Send selected student workstations a message. Messages can be sent anonymously. Past messages are 
archived.

Restrict
Blank/Unblank Screen

Allows the teacher to blank out selected student workstations.

Limit/Stop Limiting/Configure Web Limiting

This group of commands is also available on the Insight toolbar. Use this group to begin, stop, or 
configure the web limiting feature.

Limit/Stop Limiting/Configure Application Limiting

This group of commands is also available on the Insight toolbar. Use this group to begin, stop, or 
configure the application limiting feature.

Limit Printing

Limit access to any printers connected to student workstations. Selecting this toolbar command 
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displays the disabled printer icon in the student machine’s taskbar and the same icon in the status 
column in the teacher console.

Limit/Stop USB

From the console you can limit the student’s ability to access a USB flash drive. USB keyboards and 
mice will not be affected. 
 

This feature is only supported on Windows 2000 or later versions.

Administer 

One to One

Save and compare class lists (.lsc files) of students logged on to workstations. Students leaving or 
entering Insight classrooms can be discovered.

The Enrollment Messages Pane can be opened to display a log of students logging on and off Insight 
enabled workstations.

One to One is only available by double-clicking on OneToOne.exe located in the 
Utility folder on the CD or in the downloaded zip file and performing the required 
installation.

Run a program on Selected Student 

Instruct a student by opening a program or webpage on the student’s machine. When selected the Run 
Program dialog box appears, enter a executable file (.exe) or browse to the desired program.

Shutdown/Log Off/Restart Student

Instead of shutting down each computer individually, select all computers in the classroom and use the 
Shutdown, Logoff or Restart option to shut down, restart, or log users off.

If the student computers are configured to take advantage of Wake-On-LAN technology, the Insight 
teacher can Power On all student machines. Most computers are shipped with the Wake-On-LAN 
option turned off; therefore it must be turned on in the BIOS settings.
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File Send and Collect

Distribute or collect files from student computers. The student must be logged in for this feature to 
work. When collecting files, specify the destination folder on the teacher machine. Insight creates a 
sub-folder there for each student’s file. The name of the sub-folder will be [Student’s Login name]-
[Student’s Machine Name]. This way the teacher can collect a file from every student and still keep them 
organized on their machine. In its normal mode, the option to Send Files to Students is used to send 
one specific file to all selected students. 

Right-click on a student and select Send Files To Student to send files to a selected student. The Send 
Files to Students dialog is displayed. Click Browse to select the file to be sent. Specify the location where 
the files will be saved on the student computer in the All files will be copied to the following location 
on the student computer(s): field. Select the Overwrite Student File(s) if they already exist check box to 
overwrite an existing file with the same filename. Click Send Now to send the files. The Status: area 
displays the status of the file transfer.

Right-click on a student and select Collect Files from Students to collect files from a selected student. 
The Collect Files from Students dialog is displayed. Specify the location on the student computer from 
where the files will be collected. You can also specify specific filenames or wildcards for collecting the 
files. Specify the Local destination folder where the collected files will be saved. Click Browse to select 
the location. Select the Overwrite Destination File(s) (on Teacher computer) if they exist check box to 
overwrite an existing file with the same filename. Select the Delete Student File(s) after successfully 
collected check box to delete the files from the student computer after the file transfer. Click Collect Files 
to collect the files. The Status: area displays the status of the file transfer.
Retrieve and Replace Files

Consider the following scenario: A classroom of students are working on a local typing application. 
At the end of class, this application stores the student’s completed work to a local data file in the C:\
Insight Files folder. Use Collect Files to retrieve these files from all student machines and Insight will 
save each file to a separate folder on the teacher machine. The folder name will always be in the form 
[login name][machine name]. (c:\My Documents\steve-row3\data.dat)

It would be very useful if a teacher could replace these data files at the start of every class with the 
previous day’s class data. Insight allows for the creation of a staging folder in the Send Files to Students 
dialog. The staging folder is named using the wildcard: %STUDENT%.

If the local files were initially retrieved to C:\My Documents\ClassSix, copy each student’s file back 
by specifying the file name C:\My Documents\ClassSix\%STUDENT%\typing.dat. When Insight sees 
the %STUDENT% staging folder, it replaces that with the actual [login name]-[machine name] for the 
currently specified student. If multiple students are selected, the staging folder will be expanded for 
each student.

Change Student Display Name

Use the Change Student Display Name to display an alternative name in the Insight’s Machine Name 
field. This option does not alter the student’s Windows machine name. If student machines do not have 
meaningful names, use this option to better name the computers (e.g. Row 1 Column 5).

Become a Student Machine 

Converts the teacher machine into a student machine until the next reboot. 

If a new teacher workstation is being chosen, the teacher version of Insight must be installed on the 
new workstation.
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Changing a Student Channel

If enabled by an administrator using the EnableChannelSelect utility, a teacher can change student 
channels from the console. 

Remove Students From Class

Temporarily disables the Insight software on selected students’ machines. The software is activated 
when a student next logs into that machine, or through the Add Selected Student Back into Class option 
on the teacher machine.

A student’s machine that is disabled still appears in the list and displays a stop sign icon on the computer 
screen. This is a reminder to the teacher that this student is not controlled by Insight.

Update Insight on Selected Students

Insight can be updated across multiple student workstations. For more information see Update Student 
Workstations earlier in this guide.

Options

Select options to configure the Insight teacher options. For more information see Configuring Teacher 
Options later in this guide.

View
Thumbnails

Displays student workstations in the classroom in one of four thumbnail sizes. The teacher can arrange 
each thumbnail size in a layout reflecting the shape of the classroom, and this layout is automatically 
saved. The thumbnail views are updated every few seconds.

Pausing the mouse over a thumbnail image displays the student’s login name, computer name and 
enlarges the thumbnail. Right-clicking a thumbnail displays a menu of options to control that student’s 
workstation.

The student name is displayed instead of the login name, if the student name is available in the Active 
Directory.

Thumbnail View (Windows)
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Thumbnail View (Mac)

Classroom Layout Improvements

Snap to Grid makes it easier to arrange the thumbnails in the Classroom Layout view. Classroom 
Layouts can now be locked so the thumbnails will not move and tools tips can be turned off.
Windowed broadcast remembers the size of the student window

In the past, if a student resized the windowed broadcast, that size would be lost. Insight now remembers 
the size of the Windowed broadcast on the student computer.
Insight Properties Page

The properties page is a useful troubleshooting tool if you need to know what teacher is taking action 
on a particular student. It also shows the %’d of power remaining in the battery and its A/C status.
Notebook battery monitoring

Insight monitors the battery state. If the charge drops below 50% a yellow warning battery icon is 
displayed. If the charge drops below 20% a red critical battery icon is displayed. The percentage 
remaining and A/C status is also available from the new Properties menu.
Enhanced Security Monitoring Utility

The old security monitoring tool was converted into a Windows application. It now will log all traffic 
and allow you to filter based on the type of messages and who they are coming from. This allows 
administrators to find and stop inappropriate use of Insight even quicker.
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Details

Displays student workstations in a list view with column headings. The workstations can be sorted by 
clicking on any heading. Right-clicking a workstation in details view displays a list of menu options to 
control that workstation.

The student name is displayed instead of the login name, if the student name is available in the Active 
Directory.

The computers running Insight Mac are indicated by a Mac icon. Click the computers running Insight 
Mac. The features unavailable on Insight Mac are grayed out as shown below.

Details View (Windows)

Details View (Mac)

Status Window

Configure the console display options by adding the status window. This window logs all teacher 
actions providing the time and date when each action occurred.

Select All

This menu command allows the teacher to select each workstation logged on to Insight.

Refresh

The list of students is a static list. This command refreshes the list and discovers any new students that 
have entered the class.

Load/Save Profile

Available under the View menu, Profiles save key teacher settings so they can easily be loaded at a 
later time. The following settings are saved in a profile: Class lists, Thumbnail layouts, Web Limiting 
URLs and button state, Application Limiting programs and button state, Limit Task Manager/Activity 
Monitor on Student, Limit Dotted Decimal Browsing, Limit Print button state, Limit USB button state, 
Mute button state, and Blank screens messages. 
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Using the Insight Teacher Toolbar

Toolbar Configuration
Insight provides a toolbar that can be customized as per your needs. You can add or remove icons or 
separators from the toolbar, and rearrange the icons. To rearrange the icons, press the ALT key and 
drag any icon across the toolbar. 

To add or remove icons and separators, go to View>Configure Toolbar. In the Customize Toolbar dialog, 
add or remove the desired icons. If there are many icons on the toolbar and they are not visible at once, 
click the >> icon on the right of the toolbar to access the rest of the icons. 

Show Teacher’s Screen Full Screen or Windowed
The teacher’s screen can be shown to all students on the same teacher channel.

Select between a full screen or a windowed show mode. In full screen mode, the teacher’s screen takes 
over the entire student’s screen and disables each student’s mouse and keyboard.

In Windowed mode, the teacher’s screen appears in a window on the student’s machine. The students 
can re-size the window and follow along with the teacher.

Show a Student’s Screen Full Screen or Windowed
To show a student’s screen to other students, select that student and click the Show Student button. 
While the button is enabled, the selected student controls their machine and their screen will be shown 
to rest of the students in the class in Full Screen or Windowed mode.

Student Voting
Ask yes/no and multiple choice questions from the Insight console and view in real-time how many 
students have responded and how they responded.

Student Testing
Teachers can create tests with a maximum of 100 questions. The questions can be of True/False or 
Multiple Choice. Teachers can add graphics in .jpg, .png, .gif and .bmp format.

 
To access the Test Builder, click Demonstrate>Create Test or by clicking the drop-down on the Testing 
icon on the toolbar. When the Test Builder is displayed, click New and specify a unique name for the 
test. Specify the questions in True/False format or Multiple Choice format as required. Click Browse 
to select the graphic to be displayed to the student. You can cut, copy and paste questions in a test by 
using the Cut, Copy and Paste options. A newly created test can be saved by clicking Save. You can also 
open an existing by clicking Open. 
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To administer a test, select Testing>Ask Student to Take Test. Click Load to load a test that was created 
earlier. Select the Test must be finished in x minutes check box and specify a value for x. The test will 
end after the specified minutes. 

Select the Show Question Results check box to view the responses by each student in real time. The 
Test Results are displayed in the Answers area. The average score for each question is displayed in 
percentage.

 

The results can be saved in .csv format by clicking Export.

Randomize Questions in a Test

Questions are now presented to students in a random order to prevent cheating.

Run Program
Use this feature to run an application or a Web site on student computers. This can be quite useful 
for younger students who have trouble navigating to a specific web address or starting a specific 
application.

Remote Control
Take control of selected student workstations. Remotely use the mouse and keyboard on the selected 
student’s computer. While only a single workstation is displayed, actions performed by the teacher will 
occur over each selected workstation exactly the same. With Insight, the teacher can control a computer 
at the login prompt. In order to send the CTRL+ALT+DEL command to a computer during remote 
control, click on the Monitor followed by Send CTRL+ALT+DEL menu item. The teacher can switch 
between Remote Control and View Only by clicking the arrow next to the Remote Control button.

View Thumbnail Mode (Monitoring)
View up to 256 student machines at the same time. Every student’s screen will appear as a thumbnail in 
the Insight console. This icon provides a drop-down list. If you select the Selected Only option from the 
drop-down list, only the selected student workstations are displayed in thumbnail mode. The Selected 
Only option is available only in the detailed view. 

Student Screen Snapshot 
Save a student’s screen to a standard graphic file (.bmp or .jpg) by clicking on the Snapshot button.

Send a Message
Send a message to any or all students. This is often an effective way to get a distracted student back on 
task.
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Muting
The teacher can mute the speakers of the student by selecting the student, and then selecting 
Restrict>Mute Student Speakers. Student speakers can also be muted by clicking the mute icon on the 
teacher console toolbar.

Choose Random Student

This feature allows the teacher to let Insight randomly select a student. This is a fun way to engage 
students and encourage participation in the classroom.

Co-browse the Internet

Co-browse allows teacher’s to browse the web using Internet Explorer’s primary tab and have the web 
browsers on the selected student machines actually browse to the same location as the teacher. 

Blank Screens 
Blank selected student screens on the teacher channel and disable selected student keyboards and 
mouse devices. Change the text that appears on the student screens when they are blanked by clicking 
on Administer> Options> Teacher tab. The last 10 blank screens messages are saved and easily accessible 
through the arrow to the right on the blank screens icon on the toolbar. When the blank screens 
message appears on the student computers, it is now sized to better fit the screen depending on the size 
of the message.
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Limit Student Web Browsing
Temporarily disable all or selected student access to the Internet. Selecting Block all web browsing 
prevents students from accessing any Web site through any browser. This option also temporarily 
disables e-mail clients and popular instant messengers. Choosing to Allow or block the following web 
sites allows the teacher to specify lists of Web sites the students are allowed to, or prohibited from 
visiting. This feature only supports Internet Explorer and will not function on other browsers.

This option must be configured in the Options dialog (available from the Limit Web drop-down menu) 
and then turned on by clicking the Limit Web button or Restrict menu item. While the Internet is 
disabled, an icon on both the teacher and the student computer indicates that the web is disabled.

Configure whether or not the students should see the web limiting warning. The warning is a pop up 
dialog.

Some students were using dotted decimal browsing to get around the web limiting feature. If this 
option is selected, students cannot browse the web using dotted decimals. (i.e. http://70.235.50.6).

Limit Web Enhancements

In previous versions, if a student was browsing the web when a teacher clicked limit web, they could 
continue to look at any page they had currently loaded. Now, Insight will immediately redirect stu-
dents to a Limiting page, letting them know they cannot browse to that particular website.

Unlimited Internet History

Insight now prevents students from deleting their Internet Explorer browsing history and returns and 
all browsing history on that computer. 

Insight does not prevent the private browsing feature for Internet Explorer 8.
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Limit Student Applications 
Temporarily disable all or selected student access to specified software applications. This must be 
configured in the Options dialog (available from the Limit Apps drop-down menu) and then turned on 
by clicking the Limit Applications button or through the Restrict menu.

Teachers can save and load allowed or blocked application lists.

Limit Printing
Limit access to any printers connected to student workstations. Selecting this toolbar command 
displays the disabled printer icon in the student machine’s taskbar and the same icon in the status 
column in the teacher console.

Limit USB

Limit access to any USB flash drives connected to student workstations. Selecting this toolbar com-
mand displays the disabled USB icon in the student machine’s taskbar and the same icon in the status 
column in the teacher console. This will not affect keyboard or mouse devices.

Shutdown, Logoff, Restart
From the console, shutdown, logoff or restart selected student machines.

Class List
If no class lists have been saved, open the Administer menu followed by One to One and select Save 
Current Class List.

When the One to One feature is installed, the class list toolbar button allows teachers to compare a 
saved list of students against the students being monitored in the current Insight session.

This saved list can be opened to identify students that have left, or have joined the Insight classroom.

Absent students (students that were in the saved list but not present during the current Insight session) 
can be removed from the saved list.

New students (students present in the current Insight session but not in the saved list) can be added 
to the saved list.
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Using the Student Computers 
Insight is configured to run in the background on student computers. All of the functionality is 
controlled at the teacher computer, which enables the teacher to control how it is used.

Insight Student Icon
An Insight icon appears in the taskbar at the bottom right corner of the student’s computer screen. 
Placing the cursor over the icon displays which teacher channel this computer is using.

If a student single-clicks the Insight system tray icon, they can ask the teacher a question. On the 
teacher computer a question mark icon appears next to that workstation’s name. The teacher can see 
that question by hovering the mouse over the thumbnail of the student’s machine, or looking at the 
Last Question column in the details view. The question mark disappears when the teacher chats with 
the student or uses the menu Clear Student Question.

If a student double-clicks on this icon, it will bring up the student files folder where the Send/Collect 
files feature stores files.

Insight does not allow a student to mischievously unload the software or disrupt the classroom by 
unplugging the network cable.

To prohibit student access to the Insight icon, use the stealth version of the software 
available on the original CD or download that removes the Insight student icon. 
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Uninstalling Insight

Uninstalling Insight on Windows
To uninstall Insight from a teacher or student computer, perform the following steps:

1. From the Start menu, click Run. Browse to the Teacher.msi/Student.msi program.
2. Double-click Teacher.msi/Student.msi.
3. In the Uninstall Insight dialog, click Yes to uninstall the program.
4. Reboot the computer to successfully delete all Insight files.

This is not performed by the usual Add-Remove Programs option on the Control Panel. 
Because Insight is designed for a student lab environment, care must be taken to keep 
students from uninstalling Insight.

Uninstalling Insight on Mac
Insight can be uninstalled in two different ways:

To uninstall Insight from a student computer, perform the following steps:

1. Double-click on faronics_teacher.dmg/ faronics_student.dmg.
2. Double-click on Uninstall Insight.
3. Type in an administrative password.

Updating the Insight Teacher
To update Insight, run the Teacher.msi again. It automatically updates the files which are used. There is 
no need to uninstall the old version before installing the new version.

Updating Insight Student Software
Insight can be updated on the student computers without re-installing manually on each one. To 
execute the automated update task:

1. Begin by reinstalling the latest build of Insight onto the teacher machine. 
2. Copy the Student.msi file to the C:\Program Files\Faronics\Insight folder on the teacher’s 

machine.
3. In the Insight console, select the students that need an upgrade.
4. Click Administer followed Update Insight on Selected Students menu option. 

This takes a few seconds for every student selected. When it is done, select View, followed by the 
Refresh menu item (F5) to see the newly installed version on the student computers.

By default, the Teacher.msi/Student.msi file is not copied to the C:\Program Files\Faronics\Insight 
folder. Most schools do not want teachers updating student computer software. For these schools, 
an administrator can copy the Teacher.msi/Student.msi file, perform the update and then remove the 
Teacher.msi/Student.msi file.

If Deep Freeze is active on the student computers, it must be disabled during this update 
procedure to allow the new software to be installed.
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Insight Security Auditing
With a tool as easy to use and as powerful as Insight, there’s always a possibility for misuse. A student 
may be tempted to load the teacher software and disrupt a class. While it is possible to add layers of 
security to Insight to discourage misuse, overly stringent security layers would make Insight difficult 
to use.

Insight provides a registry entry for each student computer. Each time the teacher broadcasts, views, or 
blanks-out a student’s screen, or removes a student from the teacher channel list, the entry is added to 
a record that tells what action was done, when it occurred, and who did it.

If someone is suspected of misusing Insight, use the Windows utility Regedit to look at any student’s 
local registry.

To use Regedit to view a Insight action:

1. On a student computer, click Start followed by Run. 
2. In the text box, type regedit. Click OK. A Registry Editor window appears, with 

several folders. 
3. Look at the key HKEY_LOCAL_MACHINE\Software\Insight for information 

about any Insight actions that took place on this computer.

Access the security monitoring data by clicking View then Status Window. As soon as the teacher 
performs actions, the security logging data appears.
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Insight in a NAL Environment
NAL (Netware Application Launcher) is part of the Novell ZENworks package. NAL can be used to 
control the student desktop, giving students access to only administrator-approved applications. This 
can create a problem for the installation of Insight.

Insight can be configured to run properly in a NAL environment. While it is possible to create a ZEN 
package and have Insight installed automatically on each PC, this generally takes more time and effort 
than it is worth. Insight installation takes less than a minute per PC, so an entire lab is generally 
installed in under 45 minutes. It often takes that long to build the ZEN package. The easiest way to 
install Insight in a NAL lab is to:

1. Copy the Teacher.msi/Student.msi file from the Insight CD-ROM/downloaded zip file 
to a location on a file server accessible to all. (for example, \\servername\PUBLIC\IS_
CDROM)

2. Login as an administrator on each PC and run the Teacher.msi/Student.msi from that 
shared location. Install Insight as a student or teacher depending on the PC.

Note for Teacher Machines:
If the teacher’s machine is also locked-down by NAL, the Insight Teacher Icon will be unavailable. 
Instead, the hot-key sequence CTRL+ALT+L can be used to bring up the Insight Teacher menu.

Testing and Verifying
Once Insight has loaded, the Insight icon appears in the taskbar on all student machines.

Check to see what teacher channel is in use by hovering the mouse over this icon.

If the teacher machine and the student machines are all set to the same teacher channel, all should 
work properly.

Wake-On-LAN Support
Wake-On-LAN (WOL) technology can be used to remotely power-on student computers. However, 
student computers must be configured to enable WOL. The steps needed to do this vary with every 
computer model. Generally, the computer needs special hardware to support this and there is a BIOS 
switch which needs to be enabled. It is best to consult with the computer supplier to determine the 
actual steps needed.

In the Utilities folder of the Insight CD-ROM/downloaded zip file, there is a utility, WakeUp.exe, which 
can test WOL compliance.

This utility sends a WOL signal to a specified target computer. To use this utility, two computers are 
needed: the target machine and a console machine. Both need to belong to the same IP subnet. Next 
determine the physical MAC address of the target machine. From a DOS command window, run the 
Ipconfig /all command.

Once the physical MAC address of the target machine has been acquired, shut down the target machine 
and from a DOS command window on the console machine and run the WakeUp.exe utility. This sends 
the WOL signal to the target machine.

If WOL is properly configured on the target machine, it powers-on. If not, check with the hardware 
manufacturer to see what additional steps need to be taken. If WOL is not properly configured on a 
student machine the Insight teacher machine will not be able to perform a WOL Wake-Up.

The Wake On LAN List dialog box (Administer > Power On Student) lists student machines that are on 
that channel. You can delete machines from the list.
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802.11 Wireless Support

Special Hardware Requirements
Ensure that all computers are using the latest NIC (Network Interface Connector) drivers available 
from the NIC vendor.

There are two basic types of access points: residential and enterprise. A residential access point works 
fine in a home environment where several computers share an Internet link.

An enterprise access point is designed to support 50 or more clients at the same time. If there are less 
than five student computers in the class, a residential class access point may be suitable.

Installation
It is assumed that all student and teacher machines will use 802.11 wireless NIC’s. (Mixed environments 
don’t work as well.) Also, it is assumed that all wireless computers are associated to the same access 
point. Other than this, there are no other special installation concerns. Run the Teacher.msi/Student.
msi program on the teacher or student computers, as specified earlier in this guide.

Performance
The speed of the teacher’s screen broadcasts to student computers is not as good over a wireless network 
when compared to the performance over a wired network. There is no way to overcome this.

A typical wired network can send broadcast and multicast data at 100Mbits per second. An 802.11 
wireless network may only send broadcast and multicast data at 1MBit per second (a mere 1% of the 
wired speed).

In addition to the drastic bandwidth reduction of wireless networks, the access point architecture of 
802.11 will quite often add significant propagation delays to broadcast and multicast data. (This is due 
to the power save architecture of the 802.11 world.)

However, the Insight Teacher Broadcast feature will still work reasonably well. Even complex teacher 
screens should appear on student screens within three seconds. Simple teacher screen changes should 
appear almost immediately.

Wireless Performance Tweaks
To improve performance, configure the teacher access point. Since this differs from vendor to vendor, 
we can only give general guidelines. Consult the access point’s manual to see how to actually make the 
change on the particular access point.

1. Drop the Beacon Interval as low as possible. (This can go down to 50ms.)
2. Set the DTIM to ZERO. (This allows broadcast and multicast packets to be sent after every 

beacon packet.)
3. Increase the Broadcast or Multicast speed. (Not all access points allow this to be set.) 
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Installing in a Thin Client Environment
Insight has the ability to work in a Terminal Server or NComputing environment. Insight allows 
thin client machines to be used as student and/or teacher machine. You can mix-and-match thin and 
traditional client machines (fat clients) in the classroom.

The Insight Home Edition is supported on Thin Clients. However, this is limited to one 
Teacher console and three Student workstations.

Terminal Server 2003 Installation
Installation is a two step process. Initially, the TerminalServer.msi installation program needs to be run 
on the Terminal Server. This will copy all needed files to the Terminal Server but will not configure 
any Terminal Server client machine as either a teacher or student. If the Terminal Server is in Execute 
mode, the After Installation dialog will appear. Since Insight has been designed to install onto a Terminal 
Server, it is not necessary to complete this dialog. You can press the Cancel button on this dialog at any 
time.

Once you have complete this first step and the Insight files have been copied to the Terminal Server, 
Insight must be properly configured to run on each desired thin client machine. You may do this on 
one of three ways:

Manual Student or Teacher Install
Login to a thin client terminal with Administrator rights and run the SetupTSClient.exe program again. 
Follow the wizard to assign that thin client as either a Student or Teacher machine. Repeat this for each 
thin client device in the lab.

Scripting SetupTSClient.exe
To run SetupTSClient.exe from a script, there are some command-line options that facilitate this.

#x
Installs Insight with the Teacher Channel x. “x” must be a number between 1 
to 16,000.

StUdEnT Installs the Insight Student software.
TeAcHeR Installs the Insight Teacher software.

QuIeT
Disables all user interface. Run SetupTSClient.exe in “silent” mode. This option 
must be specified last in the command line.

UNINSTALL Uninstalls the Insight software from this machine.

NoLoAd
Does not auto-start the software after installation. The software will start on 
a teacher machine after the next login. On student machines it will start after 
the next reboot.

For example, if the administrator wants to silently install a teacher on channel 1, the script should be: 

SetupTSClient.exe #1 TeAcHeR QuIeT

The command line parameters are case sensitive.
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LskTSDat.ini file
The manual install procedure explained in the previous section edits the Insight configuration file (C:\
Program Files\Insight\LskTSDat.ini). If you do not wish to run the SetupTSClient.exe file on each thin 
client, you can edit the .ini file directly with any text editor such as Notepad. 

There is an entry in that file for each thin client which will be running either the Student or Teacher 
software. The format of the .ini file is as follows:

[Insight TSClient List]

WYSE001001=Teacher, Channel=1, Name=Teacher1 

WYSE001002=Student, Channel=1, Name=WYSE001002 

WYSE001003=Student, Channel=1, Name=WYSE001003 

WYSE001004=Student, Channel=1, Name=WYSE001004 

 

The first part of each line (WYSE001001 in this example) is the Client Name of that thin client. 
Each thin client device has a unique Client Name set by the manufacturer or during hardware 
configuration. You can find that name by logging into the device and entering the SET command 
from a command prompt. 

Following the Client Name is the type of Insight software to run on that thin client device (either 
Student or Teacher.) The next parameter defines which Insight Channel to use for that thin client. 
Generally, all thin client devices in the same lab will have the same Channel number. 

The last parameter defines the Insight Display Name. The student will appear in the Teacher Console 
with both the login name and this name. By default, we use the Client Name, but that can be changed 
if a more meaningful name is desired.

If you are load balancing (i.e. multiple Terminal Servers serving the same lab) you must install the 
Insight software on all Terminal Servers and then replicate the completed LskTSDat.ini file to all 
Terminal Servers.

Active Directory Installation

If the previous installation procedures do not provide sufficient flexibility, Insight can be loaded on 
demand via a login script in an Active Directory environment. You will have to be able to determine in 
the script if the thin client machine is a Student or Teacher. Please contact Faronics Support for more 
detailed instructions if you need to use this method. 

NComputing Installation
Installation in an NComputing environment is a two step process. 

Run TerminalServices.msi on the NComputing Console machine. Run SetupTSClient.exe on the 
NComputing Console machine. This will copy all needed files to the NComputing Console machine 
and configure that Console machine to run the specified Teacher or Student software.

After Insight has been installed on the Console machine, run the SetupTSClient.exe program again 
each NComputing Station machine which is attached to the Console machine. This will not copy any 
additional files but will configure an Insight configuration file (C:\Program Files\Insight\LskTSDat.
ini).

If you do not wish to manually install Insight on the Station machines, you can manually edit this 
configuration file as explained in the Terminal Server 2003 Installation section.
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